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Introduction 

 ocBuild Plus is an easy-to-use 

solution for creating ‘paperless’ 

documents using multiple, and very 

simple, processes.  DocBuild Plus provides a 

comprehensive set of tools including 

annotation, stamps, signature pad and 

electronic signature solutions integration, 

that allow users to work with and distribute 

documents as part of an overall 'paperless' 

workflow process. While the application 

provides many powerful advanced features, the 

focus of the design was on keeping the interface as simple and easy-to-use as 

possible, to minimize training needs and to allow users to begin using the application 

quickly. 

This user guide covers all key aspects of the DocBuild Plus application, while touching 

on many related concepts related to document imaging. The user may benefit from 

additional reading on topics such as document scanning, document file types and their 

benefits (i.e., TIF vs. PDF), basic Microsoft Windows network navigation, and printing 

and e-mailing concepts, amongst others. However, a user with basic knowledge of how 

to utilize modern Microsoft Windows operating systems should be fully capable of 

making full use of this guide and the software it describes.                       

D 
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Intended Audience 

This guide is intended for all levels of both IT 

support staff and end-users, who will be either 

installing/supporting the software or making 

use of it as part of daily workflow. While the 

focus will primarily be on the topics that 

standard end-users are concerned with, 

additional technical information will be given 

where appropriate that will be useful to more 

advanced users and system administrators. 

This guide is not intended to be an exhaustive 

manual on all of the related topics covered 

within. 

The following basic levels of knowledge are assumed: 

 Basic knowledge of how to use and navigate modern Microsoft Windows 

operating systems (Windows XP, Vista, Windows 7 or 8) 

 Standard modern office application concepts, such as opening and saving files, 

using toolbars and drop-down menus, and related topics. 

 Basic understanding of document imaging concepts, such as fundamentals of 

document scanning, printing, etc. 

 Basic understanding of how e-mail works. 
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Technical Conventions 

This guide will use a number of technical conventions to help the user differentiate 

between concepts and make different types of text easier to understand.  

 References to toolbar buttons or menu items will be boldface to help the reader 

differentiate them from normal text. 

 File path references will be formatted in Courier New Font Face in the form 

C:\Images\MySampleDocument.tif. 

 Useful tips will be presented in the text as sticky-note inserts to help 

summarize key points and allow for quick reference. 
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Getting Started 

his section provides the 

information necessary to 

get started with using 

DocBuild Plus. While every effort 

has been made to keep the 

application easy to use for users of 

all levels of technical ability, there 

are some key topics to understand 

that will make the application much 

easier to use effectively.  

 Application Purpose and Intended Usage 

 Installing and Configuring DocBuild Plus 

 Running DocBuild Plus for the First Time 

 Understanding the User Interface Layout 

 

T 
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Application Purpose 

The DocBuild Plus application is intended to be used in any environment where Users 

desire a versatile application for ‘paperless’ printing, viewing, scanning, annotating 

and otherwise managing standard documents. The application can be used to work 

with existing documents in PDF, TIF, JPG, BMP or GIF formats, or it can be used to scan 

new documents using almost any TWAIN-compliant scanner.  Additionally those 

formats can be drag-and-dropped onto the program window. Once a document is 

open in DocBuild Plus, it can be manipulated in various ways:  

 Virtually any document, webpage, or file can 

be easily printed into the Viewer using the 

DocBuild printer, also allowing multiple print 

jobs to be combined into a single document.  

 Certain existing files can be dragged and 

dropped onto the DocBuild Plus window, 

provided those files are in JPEG, PDF, TIFF, GIF 

or BMP format. 

 Documents can be annotated with various 

annotation tools including signatures, image 

stamps, text, highlighting, black/white 

redaction, lines and freehand drawing. 

 You can choose to save your documents 

wherever you like, including almost any 

virtual or cloud repository such as Google Docs, Dropbox or SkyDrive, to name 

a few…  thereby providing secure access from virtually any internet capable 

device. 

 A document can be saved to a new filename and/or file type, allowing 

conversion between PDF and TIFF format as needed. 

 Documents can be printed, e-mailed, faxed or sent into a third-party 

application, providing versatile means for distributing documents. 
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Installation 

Installing DocBuild Plus is as simple as running the Docbuildplus.msi file and choosing 

to accept all defaults. The following screenshots will walk you through the process. 

 

THE FIRST SCREEN OF THE SETUP PROCESS 

REQUIRES THE USER TO SELECT THE DESTINATION 

FOLDER WHERE THE DOCBUILD APPLICATION WILL 

BE INSTALLED ON THEIR WORKSTATION. THE 

USER CAN ALSO CHOOSE WHETHER THE 

APPLICATION WILL BE INSTALLED FOR ALL USERS 

OF THE WORKSTATION, OR JUST HIS OR HER OWN 

USER. IT IS RECOMMENDED THAT THE DEFAULTS 

BE SELECTED. WHEN FINISHED, CLICK THE NEXT 

BUTTON TO PROCEED. 

 

 

CONFIRM THE INSTALLATION BY CLICKING THE 

“NEXT” BUTTON. 
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ONCE INSTALLATION COMPLETES, CLICK THE 

CLOSE BUTTON.  

 

CHOOSE TO ACTIVATE THE SOFTWARE AND 

CONTINUE. 

 

YOU WILL BE PROMPTED TO ENTER IN YOUR 

LICENSE ID AND PASSWORD. THIS INFORMATION 

IS FOUND ON YOUR ELECTRONIC RECEIPT AFTER 

YOU PURCHASE THE DOCBUILD PLUS PROGRAM. 

 

ONCE YOU HAVE FILLED OUT THE INFORMATION, 

CLICK OK. 

 

THE DOCBUILD PLUS PROGRAM IS NOW FULLY 

ACTIVATED AND READY TO BE USED. 
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Launching the Application 

Once the DocBuild Plus program has been installed, a shortcut icon for DocBuild   

is placed on the user’s desktop, which can be used to launch the application.  Or, you 

can launch it by clicking your Windows Start button, and under the ‘All Programs’ 

listing, selecting the ScanPoint folder, and clicking the DocBuild Plus icon.   

Upon first launch, you will be asked if you would like to set the “DocBuild” printer as 

your default printer.  For most Users, and to maximize your automatic paperless 

workflow processes, we recommend selecting “Yes” for the greatest convenience.  

The DocBuild Plus program can also be set as the default application for opening 

certain file types after installation.  Only TIFF images are set to open by default upon 

installation (PDF, BMP, JPG, JPEG, and GIF can also be set manually if you desire). 

Once the DocBuild Plus program is launched, the standard user interface is displayed, 

which will be discussed in the next section. It may take a few moments to open 

DocBuild Plus the first time that it is run on slower, low-resource workstations. Please 

note that the first time the application is launched, it may require activation if not 

previously performed.  (Activating DocBuild Plus was reviewed in the previous section). 
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User Interface Layout 

The goal of the DocBuild Plus 

user interface (UI) design is to 

keep the overall experience 

simple and easy to use, while at 

the same time allowing advanced 

users quick access to more 

powerful features.  

When first launched from a 

shortcut, no document will be 

loaded into the application’s 

viewer window, and many of the 

toolbar options will be disabled, 

as shown in the screenshot to 

the right. Once an image is loaded, most toolbar options will be enabled for use. If a 

document is launched in the DocBuild Plus program by right-clicking a PDF, TIF, JPEG 

or BMP file, selecting ‘Open With’ and choosing DocBuild Plus , then it will launch with 

the document loaded and all options enabled. 

The two screenshots below show the standard UI displayed when an image is loaded – 

the first is the interface exactly as it appears, and the second includes explanatory 

bubbles to identify the 

key interface features. 

The numbered items in 

the bubbles will each be 

discussed in detail 

below. Note that more 

detail on each of these 

items will be provided in 

later sections dealing 

with specific 

functionalities. 

 

Figure 1 - Standard User Interface shown when launched without a 
document loaded. 

 

Figure 2 - Standard User Interface shown when a document is   launched 
into the program.  
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User Interface Component Overview 

1. Main Application Menu – the main menu presents many of the standard 

application-related options, including the File, 

Document, Edit and Help menus. Most menu items 

have a corresponding toolbar button which performs 

the same task with fewer mouse clicks. 

2. Main Toolbar – this toolbar includes some of the key 

items related to moving documents into and out of 

the application. The key buttons presented by this 

toolbar include the Open, Close, Save, Save As, Scan, 

Doc Import, Print, Fax, Email and EasyFile buttons. 

Note that, as shown by the “EasyFile” button in Figure 

3, additional buttons for sending documents into 

third-party applications may be displayed on the main toolbar, depending on 

your system configuration. The buttons on this toolbar will be discussed in more 

detail in the sections to follow. 

 

Figure 3 – DocBuild Plus application window, showing a document loaded, with explanatory bubbles 

identifying key interface features.  

 
DocBuild Plus Tool Tip 

Your interface may differ from the 

screen-shots above depending on 

how your administrator has 

configured your DocBuild Plus 

windows.  For more information 

on configuration, see the Settings 

section below. 
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3. Current File Page Navigation – these buttons allow you to navigate through the 

pages of the currently loaded document. The paging options will be discussed in 

more detail in the section later in this guide. 

4. Current Document Thumbnails – each page of the currently open document will 

be displayed here in thumbnail form, allowing the user to quickly preview each 

page and quickly navigate to specific pages within a document. A user may 

adjust the width of the thumbnail display by clicking and dragging the side next 

to the slider-bar. 

5. Display Options Toolbar –this toolbar contains buttons that affect how the 

current document page is displayed in the viewer window. Options include page 

rotation, zoom and fit options, stamp creation, and page deletion. 

6. Edit/Annotations Tab – Clicking on the Edit tab will bring up the annotations 

toolbar buttons, which allow you to apply annotations to the current page of the 

loaded document. The annotation tools will be discussed in more detail in the 

Working with Documents section later in this guide. 

7. Action Tools – With Options – Most action tools in the toolbar allow you to 

perform specific commands with your document, such as emailing selected 

pages, saving certain pages to the desktop or EasyFile*, or customizing an 

action command.    

8. Current Page View Window –this window displays the current page from the 

currently loaded document. Annotations are added to the document via 

choosing an annotation tool and clicking on the displayed page. 
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Creating Documents :  Paperless Print, Scan, Import  

ocuments created in the DocBuild Plus 

program can originate from four 

sources: they can be printed into 

DocBuild Plus using the DocBuild 

Printer, they can be scanned into the viewer 

using the built-in TWAIN scanning capabilities, 

they can be dragged and dropped 

into the DocBuild Plus program, or 

they can be opened from existing 

PDF, TIF, JPG, JPEG, BMP or GIF files. Once a 

document is open in the DocBuild Plus window, from any source, all of the 

application’s enabled features are available for working with that document.   

This section will cover all of the concepts related to opening, dragging and 

dropping existing documents and scanning documents using DocBuild Plus. 

Specific topics covered include: 

 Supported File Types 

 Opening Documents via Standard File Browsing 

 Opening Documents via Drag-and-Drop 

 Scanner Selection 

 Scanning a New Document 

 Appending Scanned Pages to Existing Scanned Document 

 

D  
ScanPoint Tool Tip 

Once a document is open in the 

DocBuild Plus viewer, all of the 

application’s enabled display and 

annotation features are available 

for use on it, regardless of 

whether it was opened from an 

existing file or scanned. 
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Opening Existing Documents 

Opening documents in the DocBuild Plus viewer is very similar to opening 

existing files in most modern applications, and should be familiar to most 

users. There are several ways that existing electronic documents can be 

opened using the DocBuild Plus viewer, and each will be discussed in turn. The key 

items covered in this section are: 

 Supported File Types 

 Opening Documents via Standard File Browsing 

 Opening Documents with "Open With" selection 

 Opening Documents via Drag-and-Drop 

 Using the DocBuild Printer 

 Using the Doc Import Feature 
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Overview 

The DocBuild Plus program supports and can open several of the 

common document imaging formats: Tagged Image File Format (TIFF 

or TIF), Portable Document Format (PDF), Graphics Interchange 

Format (GIF), and Joint Photographic Experts Group (JPEG or JPG), and 

Bitmap (BMP).  The first two file types are predominantly used for 

scanned document images, both in document management systems 

and also when scanning from a desktop scanner or copier. 

All of the key application features are available for use with all types 

of documents, and conversion between file types is supported. 

Note that in addition to the methods presented below, there is an 

additional way to open files in the application: DocBuild Plus can be 

set to be the default application for TIFF, PDF, JPG or GIF files, then 

simply double-clicking a file with that format on your workstation will 

cause it to open in DocBuild Plus. Associating file types with 

applications is an advanced topic and is beyond the scope of this 

guide; please contact your system administrator for more information 

on this topic. DocBuild Plus is automatically associated with TIFF files 

during installation. 

In addition, note that when you open a file in the DocBuild Plus 

program it will not be modified until you click the Save or Save As 

button. 

All annotations placed down on a document are flattened and not able 

to be edited in the saved file.  
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Standard File Browse 

The file browse method 

allows you to use a 

standard Open File dialog 

to select a single document 

for display in the DocBuild 

Plus program.  

This dialog can be used to 

open files both from the 

local workstation and from 

network locations, very 

similar to how files are 

opened in most modern 

Microsoft Windows software 

applications.  Note that only a single file at a time can be opened using this dialog. 

In addition to clicking folders and buttons to browse to locations on the local machine 

or network, file paths can be manually entered into the File Name box, either as a local 

path (such as C:\Images\MyDocument.tif), or to UNC network paths (such as 

\\server\Images\MyDocument.pdf). Mapped network drives are also fully supported.  

 

Figure 4 - Standard File Browse dialog. 
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Drag and Drop 

The second way to open existing documents in the DocBuild Plus program is to first 

open the program itself and then “drag and drop” a file (or files) into the viewer 

window. The steps below describe this process in more detail.  Figure 5, shown below, 

illustrates this process in graphical form.  

 

Figure 5 - Opening a document via drag-and-drop. 

1) Open DocBuild Plus by clicking its icon from the Start Menu or double-clicking 

its shortcut on your desktop. The application should open with no document 

loaded. 

2) Now click to select the PDF, TIFF, GIF, BMP or JPEG file you want to open in the 

viewer. This can either be from your desktop or from an Explorer window. 

3) Now, while holding down the left mouse button, drag it over the DocBuild Plus 

window. Once the mouse pointer moves over the application window, it should 

change to include a “+” plus sign. 

4) Once you have dragged the file you want to open over the window, release the 

left mouse button. The document should now open in the viewer window. You 

may repeat this process to drag in multiple files.  If a document is already open 

in DocBuild Plus, you will see the window refresh in a few seconds as the 

additional pages are added to the existing document.  This allows a document 

to be built from multiple smaller files. You can also drag in multiple files at the 

same time, with each being appended in order to the end of the document. 
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Scanning New Documents 

Scanning is the process of creating an electronic image of a physical paper 

document in such a way that the imaged document can be viewed and 

manipulated on a computer. By scanning your paper documents and storing 

them electronically, you can improve your efficiency, improve disaster recovery 

options, and reduce the physical impact of large amounts of paper on your business.  

DocBuild Plus supports scanning via the TWAIN standard, which is supported by most 

scanners available today. This section of the guide will walk you through the basics of 

selecting a scanner and scanning documents; however, advanced scanning concepts 

and scanner installation/setup varies from manufacturer to manufacturer, so you may 

need to refer to your scanner’s documentation for more information. The Scan button 

dropdown menu is shown in Figure 6. 

 

 

 

 

Figure 6- The Scan button dropdown on the main toolbar, with three available 

options:  1) Scan New   2) Scan Append  (append pages to currently open document) 

3) Scan Select  
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Scanning New Documents 

Scanning a new document into DocBuild Plus can 

be done at any time. If a document is currently 

open, it will be closed with a prompt to save 

changes if necessary. If no document is currently 

open, a new one will be created. The following 

steps and screenshots outline the process of 

scanning a new document using DocBuild Plus. 

Refer to the Scanner Selection instructions above 

if you have not already done so, as a scanner 

must be selected before scanning can commence. 

1)  Make sure your scanner is powered on, and that the document you want to scan 

is properly loaded.  

2) Start the scan process in one of the following two ways: 

a. Click the Scan button on the main toolbar. Note that the behavior of this 

button can be to either append additional pages to a document, or scan a 

new document. The default behavior is for additional pages to be 

appended to the existing document; however, if no document is open, a 

new document will be scanned.  You may change the default behavior of 

the Scan button through the Settings interface. 

b. Click the dropdown next to the Scan button on the main toolbar and 

choose the Scan New button. 

3) Your scanner’s interface should now be shown. This interface will vary from 

scanner to scanner; refer to your scanner’s documentation for more information 

on the options and features available. Generally you will need to click “Scan” or 

“OK” somewhere on this interface to begin the scan. 

4) The scanner should now come to life and the document should be scanned. 

5) Once scanning is complete, the newly scanned document should be displayed in 

the DocBuild Plus window, and can now be annotated, saved, printed, etc. 

 

 

 
DocBuild Plus Tool Tip 

The behavior of the Scan button 

on the main toolbar can be 

configured to always default to 

either Scan New or Scan Append. 

This is configured via the Settings 

interface. Note that the Scan 

button always defaults to Scan 

New if there is not already an 

open document active in the 

viewer. 

 



Ver2_11.2014 19 

Appending Scans 

The DocBuild Plus allows you to add additional pages to any open document via the 

Scan Append functionality. This lets you scan a large document in smaller batches; 

each new batch of pages will be appended to the end of the existing pages. For 

example, if your scanner only holds 50 pages at a time, and you have a 500-page 

document to scan, you could load the first 50, select Scan, then load the next 50 

pages, choose Scan Append, and so on, until all pages have been scanned. The end 

result in the DocBuild Plus viewer would be a single 500-page document.  You may 

also append scans to any already existing document using this method. 

Here are the steps for appending scans: 

1) Open or create a new document by: 

a. Following the steps for scanning a new document, as described above, 

OR 

b. Following the steps for opening an existing document, as described 

above. 

2) Once your document is open, load the next set of pages into the scanner and 

choose Scan Append the Scan button dropdown on the main toolbar. 

3) The next set of pages will be scanned and appended to the existing document. 

4) Repeat as many times as necessary. When finished, save/print/etc. your 

document as needed.
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Scanner Selection 

Once you have a TWAIN-compliant scanner installed on 

your workstation, it should be available to DocBuild Plus 

for acquiring documents. A scanner can be selected 

from within the application by clicking the dropdown 

next to the Scan button in the main toolbar and 

choosing Scan Select. This option is shown in Figure 7. 

Once clicked, the Select Scanner interface will be 

displayed, as shown in Figure 7. Assuming that your 

TWAIN-compliant scanner is correctly installed on your 

system, it should appear in the list. Simply select the 

scanner you want to use and then click the Select 

button. 

 DocBuild Plus will now use the selected scanner for all scans until the scanner is 

changed. 

 

 

Figure 7 - The method for 

selecting a scanner. Use the Scan 

button on the main toolbar. 
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Printing to DocBuild Plus 

One additional way of getting documents into DocBuild Plus is to use the special 

DocBuild printer to print documents directly to DocBuild Plus from any software 

application that supports printing. Doing so will render the printed item, for example a 

Microsoft Word document, web page, or email to a PDF file and display it in DocBuild 

Plus. Using the DocBuild printer can save having 

to print a document to paper and then scan it 

back in. 

If this feature is used frequently, it may be 

worthwhile to set the DocBuild printer as the 

default printer on your system. 

Print Append 

The Print Append button, shown below in Figure 8, allows documents to be printed 

into DocBuild Plus using the DocBuild printer.  The Print Append button is set, by 

default, to time-out after a specified number of seconds when the window first opens.  

When the button is disabled, a new DocBuild Plus window will be opened with the next 

printed document.  When the button is enabled, the printed document will be 

appended to the existing document, allowing multiple documents to be combined into 

one.   Users can enable or disable it by simply clicking on it.  When it is manually re-

enabled in the open viewer it remains active until manually disabled again. Time-out 

settings are adjustable to user preference in the Application Configuration settings. 

 

Figure 8 - The Print Append button disabled on the left, enabled on the right. 

 
DocBuild Plus Tool Tip 

It can be worthwhile to set the 

DocBuild printer as the default 

printer on your system if you use 

this feature frequently. 
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Doc Import 

The Doc Import button allows multiple existing documents to be merged into one 

document.  This feature is essentially a file import process.  This button opens a target 

source folder, using default settings you set in Application Settings.  When clicked, the 

Doc Import button allows you to select one or more existing files in the default source 

location, or you can navigate out to any other accessible folder(s) to acquire files.  Doc 

Import supports most image file formats including PDF, TIFF, GIF, BMP JPG or JPEG files 

that you want to import/merge in the viewer window. 

  

 

Figure 9 - The DocBuild button as shown in the Main Toolbar. 

 

In addition, you can set up this feature to delete the source file from its original 

location upon importing into DocBuild Plus.  (see Page 48 for more information on this 

feature) 
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EasyFile with Options  (if you have purchased this product – sold separately) 

EasyFile is a robust, secure, document management program that uses virtual filing 

cabinets to hold records. Once a user has clicked on the EasyFile Button, the Batch 

Index will open and allow a User to select an electronic file cabinet and file a document 

into the EasyFile System. Indexing (searchable fields) information must be entered and 

saved to be filed away into the EasyFile filing cabinet.  

The EasyFile with Options choice gives a user the ability to save only certain selected 

pages within a document into a filing cabinet. 

 

 

 

 

 

 

 

Once EasyFile with Options has been selected, a menu will open allowing the user to 

choose which pages to save from DocBuild Plus to EasyFile, and which format. 

 

 

Figure 10 – EasyFile, with options.  
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Figure 11 – EasyFile Options display menu . 

 

EasyFile with Options  (continued) 

 

1. Page Selection – Pages can be selected to save into the EasyFile system. 

All Pages – all pages in the DocBuild Plus are selected to be saved as a record 

into EasyFile. 

Selected Pages – Pages that have been highlighted or selected in the Document 

Thumbnails Display screen will be saved as a record into Easyfile. 

Page Range – Page numbers entered into the “page range” option will be 

selected to save into EasyFile. 
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2. Send File Format 

PDF –File saved into EasyFile will be in PDF format. (Portable Document Format). 

PDF with Password – File saved into EasyFile will be in PDF format and password 

protected. 

 

WARNING – by selecting to password protect your document, you are solely responsible 

for keeping track of your password. If you forget your password, the document will be 

unrecoverable. 

  

If you would like to learn more about EasyFile Content Management Solutions, 

please visit our website :  http://www.easyfilecms.com/ 

Or email us for more information:  Sales@easyfilecms.com 

 

 

http://www.easyfilecms.com/
mailto:Sales@easyfilecms.com?subject=Information%20Request%20about%20EasyFile%20CMS
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Working with Documents 

nce a document has been 

launched in DocBuild Plus, 

you are ready to begin 

working with that document. There are 

two key toolsets available within the 

DocBuild Plus that allow you to work 

with an open document: Display 

Options and Annotation Tools. This 

section will deal with the following key 

topics. Note that changes made to a 

document will not be reflected until the document is saved using the Save or Save As 

buttons. 

 Navigating the Menu Options 

 Using the Image Display Toolbar 

 Using the Annotation Tools 

O 
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Image Display Toolbar 

The image display toolbar, shown in Figure , contains page information and how 

documents are viewed in DocBuild Plus. Below is an annotated screenshot of the Image 

Display Options.    

 

 1. Zoom In/Zoom Out Slider Bar – Click and drag on the slider tab to zoom in or 

zoom out on selected page. The “+” and “-” options also allow a user to zoom 

in or out. 

 2. Page Viewing Options- Pointer Tool – The pointer tool allows annotations to 

be selected and moved around the document. Zoom 100% - displays the 

document in the viewer at its actual size. View Fit-to-Width – View the page at 

the zoom necessary for the page to display the full width on the screen.  

Vertical scrolling may be required. View Fit-to-Height - View the page at the 

zoom necessary for the page to display the full height on the screen.  

 

Figure 12 - The Image Display Toolbar.   Note that Rotate Left, Rotate Right, and Delete Page will 

physically  modify the document when saved while the other buttons will only change how the document 
is displayed on screen. 
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Horizontal scrolling may be required. View Best Fit – View the page at the zoom 

necessary for the entire page to be displayed on the screen. Zoom Selection – 

Click and hold to create a box or rectangle around an area on the document 

that you would like to zoom into. 

 3. Create Stamp – Once this button is selected, click and drag a box around an 

image in the DocBuild Plus window to create a stamp. Name your file and it will 

be available as a stamp in the stamps folder. (Further instructions on how to 

create a stamp are listed on page 28.) 

 4. Rotate Page Left – rotates the current page to the left by 90 degrees.  

 5. Rotate Page Right – rotates the current page to the right by 90 degrees. 

 6. Flip 180º – rotates the current page 180 degrees. 

 7. Delete Page – Delete the current page.  Note: page deletions will be reflected 

in the document when saved. 

 8. Current Page Navigation - these buttons allow you to navigate through the 

pages of the currently loaded document. 

 9. Print Append – A button that allows you to combine documents when it is 

enabled. Print a document while it is active and it will be appended to the 

existing document, allowing multiple documents to be combined into one.  If 

the button is enabled but no existing document is open, a new document will 

be created.      

The Print Append button is automatically activated once a document has been 

put into the DocBuild Plus program. Multiple pages can be printed into the 

program until the button times out. Once the Print Append button has timed 

out, it can be re-activated by clicking on the “Print Append” button. (Note, once 

it has been manually re-activated, it will not time-out. It can be deactivated by 

clicking on the button once more.) 

 

The default time-out settings for DocBuild Plus can be adjusted to User 

preference.  Please see Application settings section, Page 43, for more 

information. 
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Creating a Stamp 

Any portion from a document that is open in the DocBuild Plus program can be saved 

as a stamp to be placed on a document for further use. The ‘create stamp’ tool 

referenced in figure 12 allows the user to select an area on a document to copy as an 

image in the stamps folder.  (for example… you may want to create a stamp of your 

signature, initials, or special symbol) 

To begin this process, the user will click on the “Create Stamp” icon on the display 

toolbar. Once it has been selected, the cursor will then transform into an image-

clipping tool. Next, locate the image or text the user wishes to make a stamp. Using 

the mouse, click, hold down on the click, and drag the cursor down and over. The 

selected area will be determined as the new stamp. 

Once the user has specified the image they wish to create, the stamps folder will open 

and request a name for stamp. After typing in a title, click Save. The image will now be 

available as a stamp.   
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Annotation Tools 

DocBuild Plus’ Annotation Tools are a powerful set 

of components that allow you to add additional 

content, such as highlighting, text, redaction and 

signatures, to an existing electronic document. 

These tools can be used to add markup to 

documents for review by others, for adding 

electronic signatures to forms, for redacting 

content before e-mailing/printing, adding image-

based stamps such as “Confidential” or “Copy”, 

and much more. This section will describe the 

Annotations toolbar, each of the annotation tools 

in detail, and annotation-related options. 

Annotations Overview 

Annotations allow a document to be marked up in various ways, in either a temporary 

or a permanent manner. Additional text, date stamps, redaction, highlighting, image 

stamps and other items may be added to a document in the form of annotations. 

These annotations can be “branded” permanently into the document when saved, or 

kept as editable annotations that can be later removed or changed as necessary. The 

one exception to this is if the Signature annotation tool is used. Signing a document 

automatically makes all annotations permanent. 

The Annotations Toolbar 

The Annotations Toolbar is shown in Figure 13, below. Detailed descriptions of each 

tool follows. Note that the annotation buttons on the Edit toolbar are only active when 

a document is loaded in DocBuild Plus, otherwise all of the buttons are grayed out and 

inaccessible. 
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Figure 13 - The Annotations Toolbar with tool descriptions. 

 

1. Pointer Tool 

This tool changes the current tool to a standard pointer, which allows 

annotations to be selected, moved, resized, etc. This is the default tool. 

2. Pan Hand Tool 

 This tool allows the user to grip the page and navigate it by clicking and 

dragging the hand up or down.   

3. Text Tool 

This annotation tool allows text to be added to the current document, both 

single-line text snippets or multiline paragraphs. Moving the mouse pointer 

over a text annotation changes the mouse pointer to Text Edit mode, which allows you 

to left-click the annotation to edit it. (Once the text tool has been selected, further text 

options are available to the right of the tool menu.) Right-clicking a text annotation 

will bring up a context menu with many annotation-related options. The default font 

and font size may be modified in the Display tab of Application Settings. 
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To use the Text Tool, simply click the tool button to activate it and then click on the 

document where you want the text annotation to appear. 

 

 

Figure 14 – Once the Text tool has been selected, options become available. The user can make the text 

placed on the document Bold, Italic, a different font, or change the size of the font placed on 

the document. 

 

 

Figure 15 – Text Options may also be accessed by doing a right click on top of text annotations. 
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4. Date Stamp Tool 

This tool allows a date stamp to be added to the current document. The default 

font, font size, and format may be modified in the Display tab of Application 

Settings 

5. Highlighter Tool 

This tool allows you to add transparent color highlighting to a document. By 

default the highlight color is bright yellow, though this can be changed by right-

clicking the highlight annotation and choosing a new color from the context menu, or 

choosing a new color option located to the right of the tools menu. 

To use the Highlighter Tool, simply click the tool button to activate it and then draw a 

box on the document where you want the highlight annotation to go 

 

 

Figure 16 – Highlight options become available once the Highlight tool has been selected. A user may 

change the highlight color and it’s transparency.  

6. White-out Tool (White Redaction) 

This tool allows you to draw a white opaque rectangle on the document, in order 

to block out text or other content on the page (known as redaction). This tool 

functions very similar to the Highlight Tool discussed above. 

7. Black-out Tool (Black Redaction) 

Same as the White-out Tool discussed above, except that the redaction box is 

drawn in solid black instead of white. 

8. Line Drawing Tool 

Allows a straight line, or series of straight lines, to be drawn on a document. 

Once drawn, the line color and other options can be chosen by right-clicking the 

line and selecting desired options from the drop-down menu. 
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To use this tool, simply click the tool button to activate it and then click the start and 

endpoints of the line on the document viewer window.  

 

 
Figure 17 – Line options become available once the Line tool has been selected. Options include being 

able to adjust the thickness of lines, line ‘style’, and color. 

 

9. Freehand Tool 

This tool is similar to the Line Tool described above, except that it lets you draw 

a freehand line on the document.  

To use this tool, click the tool button to activate it and then click and hold the left mouse 

button down while you draw the line on the document. When finished drawing, release the left 

mouse button. 

 

10. Stamp Tool 

The Stamp Tool allows users to quickly apply an existing image file as a “stamp” 

on the document. The location where the DocBuild Plus viewer looks for existing 

stamps images can be set via the Settings dialog, and must be set to a valid directory 

before the Stamp Tool is used.  (By default, a set of standardized image stamps were 

installed on your c:\efdata\DBstamps folder).  You can add virtually any image format 

file (PDF, TIFF, GIF, BMP or JPEG) to that directory to be used as a stamp. 

To use the Stamp Tool, click the tool button to activate it, then choose a stamp from your 

stamps folder to be placed on the document. Once you have selected your stamp and clicked 

“okay”, the stamps folder will disappear and you must now create a box on the document where 

you want the stamp to go, and to a size that you want the stamp to be. The selected stamp 

graphic will be added to the source document in the place and at the size of the box you drew.   

(Tool tips – You can apply the same stamp, to multiple locations on a document, by clicking the 

drop-down arrow below the Stamp button and selecting “Multi-Stamp”.  You can also select a 

stamp by simply double-clicking it and then proceed to position and size it on the document) 
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Figure 5 - The Stamp Selection Form. 

 

11. Signature Tool 

The signature tool is a special tool used for electronically signing a document 

using a Topaz electronic signature pad (sold separately) connected to your 

computer. (currently only the Topaz Systems signature pads are supported).  Adding a 

signature annotation to a document will cause all current annotations on that 

document to be “burnt in”, thereby making them permanent on the source document. 

To use the Signature Tool, click the tool button to 

activate it, then draw a box on the document where you 

want the signature to go, and to a size that you want 

the signature to be. The Signature Form will then 

display, as shown in Figure 6, and you can use your 

signature pad to create the signature. When you click 

OK, the signature will be added to your document in 

the place and size of the box you drew. Once the 

signature is added, the document is “finalized” by 

having all annotations permanently burnt into it, so signatures should only be added after all 

other annotating is complete. 

 

Figure 6 - The Signature Capture Form. 
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Finished Documents:  Saving, Printing, Email, Faxing, etc. 

he DocBuild Plus program offers a number of 

options for saving and distributing 

documents that have been opened, printed, 

or scanned into it.  

The features that will be covered in this section 

include: 

 Saving Documents 

 Printing Documents 

 Faxing Documents 

 E-mailing Documents 

 Special Document Send Features  

(Custom Buttons) 

T 
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Saving Documents 

The process for saving documents from within DocBuild Plus should 

look very familiar to anyone who uses most Microsoft Windows 

applications. There are two possible options when saving: either 

saving the document over the original file via the Save button, or 

saving the document as a new file using the Save As button, both of which are can 

appear on the main application toolbar as discussed in the Getting Started section.   

The Save As button is the only one available (by default) when DocBuild Plus is first 

installed.  The Save button can be enabled through ‘Display’ option in the Application 

Settings.  Save As can also be accessed via the File menu. Note that no changes are 

saved to the original file until you manually click Save As or Save. 

 

 

Figure 20 - The standard Save As dialog. 
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If you want to save the current document to a folder location, name it, or save as a 

different file format, you simply click the Save As button (or choose Save As from the 

File menu).  Doing so will cause the Save As window, as shown in Figure 20, to appear. 

This window allows you to specify the folder location, file name and file format type for 

the document being saved.  Once saved, the newly saved/created document will be 

remain open and active in the viewer, NOT the previously open document. 

If simply saving changes to the original document file, click the Save button (if 

enabled). No dialog is shown, and the file is silently saved over the original. If 

annotations have been added, they will be saved as part of the file.   
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Printing Documents 

Printing documents from DocBuild Plus 

utilizes standard Microsoft Windows printing 

features. There are two key ways to print a 

document from the application: by clicking 

the Print button in the main toolbar, or by 

choosing the Print option from the File menu. 

The key difference in these two options is 

that the toolbar Print button will use the 

default printer selected in the applications 

Settings interface, and will not display the 

printer selection dialog. If no default printer is set, then the printer selection dialog will 

display. See the section below on application 

settings for more information on setting the 

default printer to be used by the DocBuild Plus 

program. 

The Print option on the File menu, on the other 

hand, always causes the printer selection dialog to 

display. A way to keep this straight is to think of 

the toolbar button as a “quick print” option, and 

the File menu option as a “print with options” 

method, which has become a sort of standard in 

modern Microsoft applications. 

It is important to note that annotations are “burnt 

in” to the document before printing, and that all 

annotations will display on the printed version 

unless first deleted. Also note that if your system 

default printer is set to the EasyFile Printer, you will need to be sure to set the default 

printer in the DocBuild Plus settings to an actual physical printer. 

 

 
DocBuild Plus Tip 

The Print button on the main 

toolbar will send the document 

directly to the default printer. The 

Print button on the File menu will 

always cause the printer selection 

dialog to display. 

 

 
DocBuild Plus Tip 

All annotations are included in the 

printed version of a document. 
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E-Mailing Documents 

E-mailing a document from DocBuild Plus 

allows you to quickly and easily distribute 

documents in electronic form to one or more 

recipients, using your default e-mail client 

software. 

To e-mail a document, simply click the Email 

button on the main toolbar when you have a 

document open in DocBuild Plus.  

If the standard Email button is pressed, the current document will be added to a new 

outgoing mail message as an attachment, and a default subject and message body will 

be added. Documents are always mailed in PDF format, even if the source document is 

a TIFF. 

You can then change the recipients list, message subject and body as necessary. It 

should be noted that the e-mail interface used is 

similar to the built-in Microsoft Windows Send 

To->Email feature, and that user-specific 

preferences such as e-mail stationary and 

signatures will not automatically be added. 

However they can be manually added to the 

message, and all other features available in your 

e-mail client should also be available. If you do 

not have a default e-mail client currently configured, please contact your system 

administrator. 

The Email drop-down arrow will open the extended Email menu, as seen in Figure 21 

above. Quick Email will launch your current email program and automatically attach the 

document that’s open in DocBuild Plus.  The Email with Options selection will provide 

even more options and document control, as described on the next page.

 
DocBuild Plus Tip 

Documents are always e-mailed in 

PDF format, even if the source 

document is a TIFF. 

 

 

Figure 21 – The Email Button, with Options 
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Email With Options 

 

 

 

 

 

 

 

 

 

 

 

1. Page Selection 

Choose pages to be sent to an email. All Pages will select all pages within the DocBuild 

Plus program to be emailed. Selected Pages will only submit pages that have been 

manually selected in the DocBuild Plus page menu. Page Range will send any pages 

that have been specified by the user. 

2. Attachment Name 

Field where the user can name their PDF attachment. 

3. Send File Format 

Specify if PDF is sent as a standard PDF or protected with a password. 

4. Password 

If PDF with Password is selected, enter in password in this field.   

WARNING – by selecting to password protect your document, you are solely responsible for 

keeping track of your password. If you forget your password, the document will be 

unrecoverable. 

5. Confirm Password 

Confirm password entered in “password” field. 

 

Figure 22 – The Email Options Display Menu 
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Faxing Documents 

Faxing documents from DocBuild Plus is only 

possible if you have a Print-to-Fax Driver installed. 

Faxing from within the application requires that the 

default fax driver first be selected on the Settings 

interface. In every other way it resembles printing a 

document to a regular printer. 

Note that you can always just use the Print option to 

send via a print-to-fax driver as well – using the Fax 

button on the main toolbar simply allows you to do 

so with a single button click. 

For more information on the Default Fax Driver 

setting, see the section on the Settings interface later 

in this guide. 
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Special Document Send Options (Custom Buttons) 

DocBuild Plus also allows you to create up to three of your 

own "Custom buttons" that support sending or saving 

documents to many third-party applications, automated 

workflows, or document repositories... including Cloud 

based accounts like Box, DropBox, GoogleDocs, Skydrive 

and more.  

If you enable this functionality in your installed version of 

the application, additional buttons will be displayed in the 

main toolbar, just to the right of the Email button.  You'll 

even be able to label the button as desired and also place 

your own graphics to be used on each button.   

Clicking on your custom buttons will create a finalized version (i.e., with annotations 

“burnt in”) of the current document to be sent to the target application.  The interface 

that displays following this will vary from application to application. 

 

See "Configure Custom Buttons" on Page 52 for more information.
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Applications Settings 

he DocBuild Plus program allows certain 

settings to be specified that affect how the 

application behaves. These settings can 

help customize a specific installation of the 

application to an individual user’s workstation and 

profile. Most of these settings are stored on a per-

user basis, allowing different profiles for different 

users of the same machine. 

This section will outline the configurable settings for the DocBuild Plus viewer 

application, providing suggested defaults where appropriate. Topics covered by this 

section include: 

 Overview of the Settings Interface 

 Settings Details 

T 
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Overview of Settings Interface 

The settings interface is accessed by clicking on the File tab, and choosing to open the 

Applications Settings button on the bottom right of the menu screen. The Application 

Configuration menu will open up as seen in Figure 23.  Each of the numbered items 

will be discussed in detail in following the settings image below. 

It should be noted that no settings are saved until the OK button is pressed; if the 

Cancel button is pressed, or the window is otherwise closed, no settings changes will 

be committed. Some settings changes may require the application to be restarted 

before they will take effect.  

 

 

There are four subsets of settings available in the DocBuild Plus viewer: General, 

Display, EasyFile, and eSign 
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 “GENERAL” Settings Tab 

1. Append Scans by Default 

This setting will cause the Scan button on the main toolbar to append pages to an 

existing document instead of starting a new document. When selected, after the 

first portion of a document is scanned, the user can just press the Scan button to 

append each subsequent set of pages. If not set, the Scan button will always start a 

new document (with a prompt to save if necessary).  

2. Show Scanner UI 

This setting controls whether the scanner driver interface will be shown when 

scanning new documents. If not set, DocBuild Plus will initiate a scan using the 

scanner’s default settings. If set, then the scanner driver’s interface will always be 

shown. It is recommended that the Scanner UI display be turned off only if you are 

certain that your scanner supports no-UI mode. 

 3. Active Thumbnails 

When activated, it will burn annotations into the thumbnail pages so you can see 

them. It also will rotate the thumbnail page if you rotate the page on screen. 

4. Enable Scanner Memory Transfer Mode 

Scanner Memory Transfer Mode scans directly to the computers’ memory and is 

typically utilized only when certain scanners have difficulty or display errors using 

their built-in processes (native mode). Native mode scans directly to file and is 

considered to be more compatible with a wider variety of scanners. 

 5. PDF Raster DPI 

This controls the resolution of the quality of thumbnails on the screen. 
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 6. Image DPI 

This controls the resolution of the quality of images saved into a PDF file once the 

annotations are burned into the page. 

 7. Color Bit Depth 

When the user places an annotation on a document the annotation is “burned into” 

the document.  This will set the number of colors the final document has.  The 

lower the bits the less colors and the smaller the file size 

 8. Recent Files List Length 

Allows user to adjust how many Recent Documents are displayed in the File tab. 

 9. Clear List 

Clears the recent files listed in the “Recent Documents” tab. 

 10. Reset to Defaults 

Clears out changes to settings that have been adjusted manually, and resets all 

custom settings and window display sizing to default the default size. 

 11. Clear Temp Files 

Erases all temporary files that get generated during document creation process. 

 12. Reset Window Default Size 

This button resets the DocBuild Plus window size to its original initial opening size 

as set during installation. 

 13. Deactivate License 

Use this feature to deactivate and reset your DocBuild Plus license on this computer 

before installing and reactivating the license on another system. 
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 14. Debug Mode 

This setting enables Debug Mode which will cause the Viewer to show more 

detailed messages should an error occur.  This setting should remain disabled 

unless you are experiencing issues using the application. 

 15. Stamps Directory 

This setting controls where the Stamp annotation tool will look for stamp images. If 

this setting is not defined, then the Stamp tool will be unavailable. Note that only 

GIF, JPG, BMP and PNG files are supported by the Stamp tool. 

 16. Default Save Path 

This is the default path where documents will be saved.  It is also the folder that the 

DocBuild Plus first browses to when you open a document by clicking the Open 

button or Open menu item in the File menu. 

 17. Print Temp Folder 

This is the path for the directory in which temporary files are created by the 

EasyFile Printer when a document is printed. Correctly setting this is required to 

make use of the Print Target functionality. 

 18. Doc Import Folder 

This is a pointer to a folder where a user might temporarily place documents that 

will be imported into the DocBuild Plus application.  This path can be set to a local 

folder on the users’ computer, or it can be set to any network accessible folder or 

virtual repository folder (such as Google Docs, DropBox, SkyDrive, etc.) 

 19. Delete After Import 

This feature deletes the original source file from its folder location upon using the 

DocBuild button to import the file into the DocBuild Plus program.  This function is 

used to eliminate the need to manually remove source files upon processing. 
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 20. Fax Driver 

This setting specifies the default printer driver that is to be used for sending faxes 

from within DocBuild Plus. This setting must be specified for the Fax button on the 

toolbar to be useful. 

 21. Default Print Driver 

This setting specifies the default print driver that DocBuild Plus will attempt to use 

when the user clicks the Print button on the main toolbar. If not set, the user will be 

presented with the printer selection dialog. Configuring this setting is required for 

the “quick print” functionality to be possible within the viewer. The DocBuild printer 

should not be selected as the Default Print Driver to avoid circular document 

creation. 

 22. Default Email Document Name 

You can enter a default file name in this box that will be automatically created for 

any file that you send using the EasyFile button on the toolbar.  You can, of course, 

use the “Email with Options” selection if you prefer to create a specific name for 

your attachment (see page 40 more information). 

 23. Check For Updates 

This sets the frequency of how often the software automatically checks for updates. 

The default value is 7 days. The other values are 0=never, 1 day, or 30 days. 

 24. Enable Config Password 

When enabled, a password must be given in order to change the DocBuild Plus’ 

settings.  The first time this is enabled a minimum 6-character password must be 

entered in both Password and Password Confirm boxes. 
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Figure 24 – The DocBuild Plus Display Settings Interface. 

 “DISPLAY” Settings Tab 

 25. Enable Document RibbonBar 

This setting enables the Document Tab which is displayed horizontally along the 

top of the DocBuild Plus Window.  If enabled, you may separately enable the 

buttons contained within the Main Toolbar: the Open, Save, Save As, Scan, Print, 

Fax, Email, and Doc Build buttons. 

 26. Enable Print Option Default 

If preferred, you can set this button to default to 'Print w/ options' when clicked 

(instead of it processing the entire file by default when clicked).  Refer to Page 39 

for information on this feature. 
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 27. Enable Fax Button Option Default 

If preferred, you can set this button to default to 'Fax w/ options' when clicked 

(instead of it processing the entire file by default when clicked).  Refer to Page 42 

for information on this feature. 

 28. Enable Email Button Options Default 

If preferred, you can set this button to default to 'Send w/ options' when clicked 

(instead of it processing the entire file by default when clicked).  Refer to Page 41 

for information on this feature. 

 29. Configure Custom Buttons 

DocBuild Plus allows you to create up to three (3) of your own Custom Buttons for 

the toolbar.  This functionality enables you to configure DocBuild Plus to 

interact/integrate with other applications, folders, and processes that you may find 

useful.  In addition, you can even add your own graphic and label to the button to 

make it even more identifiable and unique.  There are three supported methods 

that your custom buttons can be configured to perform: 

Save to Folder - can be set to local, network, or cloud folders (including cloud 

account folders like Box, DropBox, GoogleDocs, Skydrive and more), or process 

folders for other software applications that launch a process when a file is saved 

into a specific folder (sometimes referred to as a hotfolder). 

Send to Application - can be pointed to executable files, used by other third-party 

applications (including many Document and Content Management Solutions) that 

launch or run specific processes or workflows.   

Send to Printer - can be set to use any print devices or "print" processor found in 

your Window's devices and printers. 

 30. Enable Bottom Toolbar 

This button enables the Thumbnail Pane, the pane on the bottom of the screen that 

displays a thumbnail of each page in the document. 
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The Print Target Timeout settings can be enabled and adjusted here. This affects 

the “Print Append” function- it is timed in seconds and affects how long a user has 

to print a document into the DocBuild Plus window before de-activating. If the Print 

Append function times out, the user can active the Print Append button manually, 

and it will remain active until manually turned off.  

 31. Enable Edit RibbonBar 

This setting enables the Annotations Toolbar which is displayed horizontally along 

the bottom of the EDIT Tab. If enabled, you may separately enable the buttons 

contained in the Annotations Toolbar: the Pointer Tool, Text Tool, Block Highlight, 

White-out Redaction, Black-out Redaction, Line Tool, Freehand Tool, Stamp Tool, 

Signature Tool, and Date Stamp.  The Text Tool and Date Stamp also have 

configurable settings which are explained below. 

 32 Enable Text Tool 

This setting enables the Text Tool annotation.  If enabled, you may set the default 

Font and Font Size. 

 33. Enable Date Stamp 

This setting enables the Date Stamp annotation.  If enabled, you may set the default 

Font, Font Size, and Format. 

 34. Advanced Image Fix  

In some printing environments or applications the output quality of certain 

documents may not provide the best appearance.  These settings for the DocBuild 

printer provides user choices as to which default method it should apply when 

accepting ‘printed’ documents.   

The three settings are: 

 None - It does not try to fix the pages. (this is the default setting) 

 Ask -  It will ask on the first page coming in if you want to apply the fix, and  

  only while the current DocBuild is in “print append” mode. 

 Automatic - it will try to fix all pages from all print jobs where incorrect fonts,  

  overall print quality is degraded, or other anomalies appear. 
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Figure  25 - The DocBuild Plus EasyFile Settings Interface. 

“EASYFILE” Settings Tab 

 35. Enable EasyFile 

Select this feature to activate and display the EasyFile (Content Management 

System) button on the toolbar.  *This would only apply to DocBuild Plus customers 

who have also purchased our full-featured EasyFile CMS solution. 

 36. Enable EasyFile Button Default 

Allows user to set a preferred default setting when clicking on the EasyFile Button. 

Please refer to Page 24 for a description of the available options. 

 37. Clear File after Save 

The current document that is open in the DocBuild Plus program window will clear 

after the record has been saved into EasyFile. 
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 38. Enable EasyFile Web Search Button 

This setting enables the EasyFile Web Search Button to appear on the toolbar.  This 

should only be enabled if you have purchased and utilize the EasyFile Content 

Management Solution, and if EasyFile has been configured by your Administrator to 

support this functionality.  If you are unsure of the Gateway URL, please see your 

administrator. 

 39. Gateway URL/Secondary Gateway URL 

*For EasyFile CMS users only - These fields indicate the local area network and/or 

the Internet based access path for EasyFile Web portal login page. 

 40. Retrieve Configuration 

*For EasyFile CMS users only – after installing and licensing DocBuild Plus, Users 

can click this button to retrieve both their URL (EasyFile Web) and URI (database and 

image path settings) for EasyFile. 

 41. Profile Configuration 

*For EasyFile CMS users only – for Advanced users, or where automatic retrieval of 

configuration does not populate the connection profiles… Users can manually enter 

connection profiles. 

 42. Default File Format 

This selection allows EasyFile CMS users to choose the type of file format to save 

documents that are created in DocBuild Plus.  The default format is PDF, but TIFF is 

also an available format   
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Figure 26 – The DocBuild Plus e Sign menu. 

“eSign” Settings Tab 

 43. Enable *EchoSign 

Enter account information to link to your Echosign account. Once enabled, the 

option to send a document using EchoSign or DocuSign will be available. 

 44. Enable *DocuSign 

Enter account information to link to your DocuSign account. Once enabled, the 

option to send a document using EchoSign or DocuSign will be available. 

 45. Send Document Separately 

When separate documents have been printed or combined into a single DocBuild 

Plus window… This setting allows users of DocuSign eSignature to have those files 

uploaded into DocuSign as separate documents within a single ‘envelope’.  This is 

most useful where different signature templates may be used or auto-applied .... 
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When this feature is not set as default choice (by clicking the checkbox), documents 

created in DocBuild will be uploaded into DocuSign as one multipage document. 

 46. DocuSign Button Default 

This setting allows users to select a preference for the default upload setting when 

clicking on the DocuSign button on the DocBuild Plus toolbar.  There are two 

settings to select from... the standard (and generally recommended setting is 

"Send Document".  The other available option is "Send Selected Pages" and would 

typically be used for Users that want to pre-select specific pages within documents 

and have only those pages uploaded into DocuSign.  If this option is not set as the 

default setting... you can always choose to "Send Selected Pages" when needed by 

simply choosing it from the drop down arrow below the button. 

 47. Username/Password fields  

These fields are where you enter/store your eSignature account login name and 

password.  Upon doing so, when you click on your DocuSign or EchoSign button, 

DocBuild Plus automatically authenticates and passes your credentials into those 

systems… thereby eliminating the need for users to have to manually login. 

* Please refer to the “eSignatures” section (page 57) for more information. 

 48. Launch in Browser . 

Launches and displays your uploaded document(s) using your default internet 

browser.  This is the preferred and recommended setting. 
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eSignatures 

DocBuild Plus currently provides an integration button for two popular eSignature 

services, DocuSign and EchoSign, and may accommodate other signature programs in 

future updates.  With our built-in eSignature integration, your document(s) can easily 

be sent into your account portal with just a single click.  Your eSignature account 

automatically launches in your Internet browser and your document(s) are now 

available for you to perform any tasks prior to sending.  Apply predefined templates, 

or add custom 'tags' and signature fields to documents that don't have predefined 

templates... or perform any other functions provided within your eSignature account. 

 

*eSignature services are integrated to external subscription accounts, purchased by Users 

directly from those Vendors, and are not a part of the DocBuild Plus program.   DocBuild Plus 

does not perform any eSigning tasks... it simply automates the entire front-end process to 

create the PDFs and upload them with just a click or two of the mouse.  Actual training for 

performing eSigning tasks are provided through your eSignature provider. 

 

To set up the DocBuild Plus program for eSignature use, open the Application 

Configuration menu located in the DocBuild Plus. Click on the “e Sign” tab located at 

the top of the Applications Configuration menu and a panel will open requesting 

account information.  (as shown on Page 55, figure 26) 

 

Activate the eSignature account options by clicking on the checkbox of the e-sign 

service corresponding with account information. Account username and password is 

provided by third party e-Signature service when signed up with an account at Echo 

Sign or DocuSign or another accommodated program. 

The DocSign menu accepts a default title for the Subject Line. This can be left blank to 

be filled in manually or entered in to be pre-filled. A default message may also be 

entered in the “Default Email Body” section.  

Once account information has been entered and completed, click “okay” and a 

DocuSign or EchoSign button will appear and be active on the Document Menu Bar.  

Once a document is completed and ready to send with an e-Signature program.  
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E-Signatures with EchoSign 

 

Click on the EchoSign or DocuSign button. A panel will open up, as seen on the 

following page, to initiate the process.  

 

ENTER THE EMAIL ADDRESS YOU WISH TO SEND THE 

DOCUMENT TO IN THE “SEND TO” FIELD. 

 

IF YOU WISH TO PUT IN A NAME OF THE PERSON YOU 

ARE SENDING TO, ENTER THEIR NAME IN THE 

“NAME” FIELD 

 

DOCUMENT NAMES CAN BE ENTERED BEFORE 

SENDING 

. 

 

Once information has been entered and the “Send” button has been pressed, your 

document will be uploaded into your e-signature program to be prepped, according to 

whatever normal steps you would follow per their process, and sent to your recipient 

using the information provided.  

 

For more information on EchoSign eSignature solution visit : 

The Echosign homepage at:    https://www.echosign.adobe.com/ref/S54K8R8G64373W 

 

 

 

 

 

 

https://www.echosign.adobe.com/ref/S54K8R8G64373W
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E-Signatures with DocuSign 

 

Once the file is ready to be uploaded into DocuSign, proceed by clicking on the 

“DocuSign” button.  Please note that any annotations you apply to a document in 

DocBuild Plus prior to being sent into DocuSign will not be recognized, and will be 

removed from the file. Tools to annotate pages are provided in DocuSign and can be 

applied there. 

Upon clicking the DocuSign button, your files are uploaded into DocuSign and a 

console window opens. Here you can proceed with applying signature and information 

fields directly on the document.   

 

 

 

For more information on DocuSign eSignature solutions visit : 

The DocuSign homepage at:    https://www.docusign.com 

https://www.docusign.com/
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DocBuild Plus Software Updates 

 

DocBuild Plus automatically checks for 

updates once every 7 days (default setting 

that occurs during installation).  You can 

modify the automatic check for updates 

settings in the ‘Application Configuration’ 

settings.  The other values are 0=never,      

1 day, or 30 days. 

 

You can also manually check for updates at any time 

by going to the Help menu and choosing Check for 

Updates. (* Note - You should close any existing 

documents open in the window prior to proceeding).  

This action will close the current Viewer window and 

open the updater window.  If an update is available, it 

will automatically be downloaded and installed and will 

re-launch the newly updated Viewer application.         

If no update is available, the DocBuild viewer will 

indicate it is running the most current version. 

The DocBuild Plus software may only be updated if an active license is present; a trial 

installation of the application cannot be updated in this manner.  If the Help menu is 

not available, consult with your administrator. 

 

Figure - 27 - Access the Help Tab on 

the located on the main toolbar. 

Click the “Check for Updates” button 

to launch a search for updates. 


